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Limited Warranty

The GPIB hardware is warranted against defects in materials and workmanship for a
period of two years from the date of shipment, as evidenced by receipts or other
documentation.  National Instruments will, at its option, repair or replace equipment that
proves to be defective during the warranty period.  This warranty includes parts and
labor.

The media on which you receive National Instruments software are warranted not to fail
to execute programming instructions, due to defects in materials and workmanship, for a
period of 90 days from date of shipment, as evidenced by receipts or other
documentation.  National Instruments will, at its option, repair or replace software media
that do not execute programming instructions if National Instruments receives notice of
such defects during the warranty period.  National Instruments does not warrant that the
operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and
clearly marked on the outside of the package before any equipment will be accepted for
warranty work.  National Instruments will pay the shipping costs of returning to the
owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate.  The
document has been carefully reviewed for technical accuracy.  In the event that technical
or typographical errors exist, National Instruments reserves the right to make changes to
subsequent editions of this document without prior notice to holders of this edition.  The
reader should consult National Instruments if errors are suspected.  In no event shall
National Instruments be liable for any damages arising out of or related to this document
or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO
WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
CUSTOMER'S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE
ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER.  NATIONAL INSTRUMENTS WILL NOT BE
LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF
PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF
THE POSSIBILITY THEREOF.  This limitation of the liability of National Instruments will
apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause
of action accrues.  National Instruments shall not be liable for any delay in performance
due to causes beyond its reasonable control.  The warranty provided herein does not
cover damages, defects, malfunctions, or service failures caused by owner's failure to
follow the National Instruments installation, operation, or maintenance instructions;
owner's modification of the product; owner's abuse, misuse, or negligent acts; and power
failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.



Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any
form, electronic or mechanical, including photocopying, recording, storing in an
information retrieval system, or translating, in whole or in part, without the prior written
consent of National Instruments Corporation.

Trademarks

NI-488.2™ is a trademark of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective
companies.

WARNING REGARDING MEDICAL AND CLINICAL
USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to
ensure a level of reliability suitable for use in treatment and diagnosis of humans.
Applications of National Instruments products involving medical or clinical treatment can
create a potential for accidental injury caused by product failure, or by errors on the part
of the user or application designer.  Any use or application of National Instruments
products for or involving medical or clinical treatment must be performed by properly
trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent
serious injury or death should always continue to be used when National Instruments
products are being used.  National Instruments products are NOT intended to be a
substitute for any form of established process, procedure, or equipment used to monitor
or safeguard human health and safety in medical or clinical treatment.
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About This Manual
                                                                                                                                                 

This manual contains instructions to help you use the National Instruments GPIB
analyzer software for Windows.  The analyzer software is intended for use with Windows
version 3.1 or higher.  This manual assumes that you are already familiar with Windows.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction, gives an overview of the GPIB analyzer.

• Chapter 2, GPIB Analyzer Windows, describes each of the windows in the GPIB
analyzer program.

• Chapter 3, How To, describes how to accomplish specific tasks within the GPIB
analyzer application.

• Chapter 4, Tutorial, contains a hands-on tutorial to help you practice using the
different features of the GPIB analyzer.

• Chapter 5, Examples, contains several case scenario examples to show you how you
might use the analyzer to solve your IEEE 488 problems.

• Appendix A, Common Questions, answers common questions about the GPIB
analyzer.

• Appendix B, Keyboard Commands, lists keyboard shortcuts that you can use within
the GPIB analyzer.

• Appendix C, Capture Display Mnemonics, explains the mnemonics that appear in the
capture display of the GPIB analyzer.

• Appendix D, Customer Communication, contains forms you can use to request help
from National Instruments or to comment on our products and manuals.

• The Glossary contains an alphabetical list and a description of terms used in this
manual, including abbreviations, acronyms, metric prefixes, mnemonics, and
symbols.

• The Index contains an alphabetical list of key terms and topics in this manual,
including the page where you can find each one.
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Conventions Used in This Manual

The following conventions are used in this manual.

bold Bold text denotes menus, menu items, or dialog box buttons or
options.

bold italic Bold italic text denotes a note, caution, or warning.

bold monospace Bold text in this font denotes the messages and responses that
the computer automatically prints to the screen.

italic Italic text denotes emphasis, a cross reference, or an
introduction to a key concept.

monospace Text in this font denotes text or characters that are to be
literally input from the keyboard, sections of code,
programming examples, and syntax examples.  This font is
also used for the proper names of disk drives, directories,
programs, subprograms, subroutines, device names, functions,
variables, field names and filenames.

< > Angle brackets enclose the name of a key on the keyboard—
for example, <PageDown>.

Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and terms are listed in
the Glossary.

Related Documentation

The following documents contain information that you may find helpful as you read this
manual.

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface for
Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 
Protocols, and Common Commands

• Microsoft Windows User’s Guide, Microsoft Corporation

Customer Communication

National Instruments wants to receive your comments on our products and manuals.  We
are interested in the applications you develop with our products, and we want to help if
you have problems with them.  To make it easy for you to contact us, this manual
contains comment and configuration forms for you to complete.  These forms are in
Appendix D, Customer Communication, at the end of this manual.
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Chapter 1
Introduction
                                                                                                                                                 

This chapter gives an overview of the GPIB analyzer.

GPIB Analyzer Overview

The GPIB analyzer is an application that you can use for testing, debugging, and analysis.
It can monitor, capture, and participate in bus activity on the GPIB.  You can use the
GPIB analyzer to test and debug your own applications by monitoring and capturing
GPIB activity while your application is running.  The analyzer also has tools to help you
analyze the data that you capture.  Analyzing this data can help you solve many of the
difficulties associated with GPIB communication, such as addressing inconsistencies,
protocol violations, and simple bus timeout conditions.

Online Help

The GPIB analyzer program includes an online help system, which you can access while
running the analyzer by pressing <F1> or using the Help menu.  The online help contains
basically the same information as this user manual.

Windows of the Analyzer

The analyzer, created with the National Instruments LabWindows®/CVI development
environment, consists of several major windows.

• Main window Contains all other windows of the GPIB analyzer.

• Action window Contains three controls: Capture, Capture & Trigger,
and Off.

• Settings window Displays settings the analyzer uses for capturing and
triggering, and allows you to change settings.

• Capture Display window Displays captured GPIB events.

• Bus Monitor window Displays the real-time status of each of the GPIB data
and control lines, and allows you to change the state
of the lines.

• Find window Specifies criteria to search for in a capture display.
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Monitoring GPIB Activity with the GPIB Analyzer

With the GPIB analyzer, you can monitor the status of all the GPIB lines.  When
monitoring the GPIB, you can toggle switches to manually assert or unassert signal lines
at any time to perform tasks such as stepping through the states of the source or acceptor
handshake.  You can also choose to manually accept one byte at a time.

Capturing Data with the GPIB Analyzer

The analyzer can capture and display data, including any combination of the following
GPIB events:  data transfers, command transfers, control line transitions, handshake line
transitions, and parallel poll responses.  You can participate in handshaking or do a
non-intrusive capture.

You might want to capture and display data based on a specific bus event without
knowing when the event might occur.  In this case, you can specify a trigger condition
and capture any number of events before and after the trigger condition occurs.  The
capture operation proceeds according to how you set the capture settings in the Capture
Settings window.

The analyzer can perform the acceptor handshake while capturing, and you can choose to
time stamp each captured event relative to the previous captured event.  The number of
capture samples you can store is limited only by the memory available on your computer.

Analyzing Captured Data with the GPIB Analyzer

The GPIB analyzer provides several features to help you analyze data that you have
captured:

• Use markers for highlighting and examining specific transactions in the captured
data, and for determining elapsed time between captured events.

• Use the flexible pattern-search utility to locate specific bus patterns.

• Store captured data to disk for later review in the Capture Display window.

• Print captured data to a selected printer.

You can reload previously saved transactions for further review and analysis.  You can
even have multiple Capture Display windows open, so that you can analyze current bus
activity in one window and the previously captured data in another window.
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Installing the GPIB Analyzer

For detailed instructions on how to install the GPIB analyzer software, refer to your GPIB
getting started manual.

Note: If you already installed the NI-488.2 software for Windows, the analyzer
software may already be installed on your computer.

Starting the GPIB Analyzer

To launch the GPIB analyzer program, double-click on the GPIB Analyzer icon in the
GPIB Analyzer Software group in Windows.
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Chapter 2
GPIB Analyzer Windows
                                                                                                                                                   

This chapter describes each of the windows in the GPIB analyzer program.

The analyzer consists of several major windows.

• Main window Contains all other windows of the GPIB analyzer.

• Action window Contains controls to turn capturing off and on, and to
turn on both capturing and triggering.

• Settings window Displays settings the analyzer uses for capturing and
triggering, and allows you to change settings.

• Capture Display window Displays captured GPIB events.

• Bus Monitor window Displays the real-time status of each of the GPIB data
and control lines, and allows you to change the state
of the lines.

• Find window Specifies criteria to search for in a capture display.
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Main Window

The Main window contains all the windows of the GPIB analyzer.  The Action window
and Bus Monitor window are always open.  Figure 2-1 shows the Main window.

Figure 2-1.  Main Window of the GPIB Analyzer

Choosing New Capture Display from the File menu opens a new, active Capture
Display window.  When you start capturing GPIB events by selecting one of the capture
buttons in the Action window, you can view them in the active Capture Display window.

Choosing Open Capture Display... from the File menu opens a previously saved
window of captured GPIB events as an inactive display.  Filenames for GPIB analyzer
capture files typically use the .CAP extension.

Choosing Exit from the File menu closes the GPIB Analyzer application.  The analyzer
prompts you to save any Capture Display window that contains unsaved GPIB events.
The current settings, as specified in the Settings window, are saved automatically, and
they are automatically loaded the next time you open the GPIB analyzer.
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Choosing Change Settings... from the Settings menu opens the Settings window so that
you can change the settings used for capturing GPIB events and triggering on specific
GPIB events.

Choosing Load Settings... from the Settings menu opens a file of previously saved
settings to be used for capturing GPIB events and triggering on specific GPIB events.
Filenames for GPIB analyzer settings typically use the .SET extension.

Choosing Save Settings As... from the Settings menu allows you to save the current
settings, as specified in the Settings window.  Whenever possible, use the .SET
extension for GPIB analyzer settings filenames.

The Windows menu lists all of the currently open GPIB analyzer windows.  When you
select a window from this menu, it is brought to the front.

The Help menu accesses the online help system for the GPIB Analyzer.  It also accesses
information about the analyzer software, such as version number and hardware
configuration.

Action Window

The Action window contains controls you can use to turn capturing off and on, and to
turn on both capturing and triggering.  The Action window is automatically open when
you start the GPIB analyzer.  Figure 2-2 shows the Action window.

Figure 2-2.  Action Window

Clicking the Off button causes the analyzer to stop capturing GPIB events and stop
looking for trigger conditions.

Clicking the Capture button causes the analyzer to begin capturing GPIB events into all
active Capture Display windows.  The analyzer captures data according to the current
configuration in the Settings window, but it does not look for any trigger condition.

Clicking on the Capture & Trigger button causes the analyzer to begin capturing data
into all active Capture Display windows and to look for trigger conditions.  The analyzer
captures data and looks for trigger conditions as specified in the Settings window.
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Bus Monitor Window

The Bus Monitor window allows you to monitor and control each of the 16 GPIB signal
lines.  It also allows you to accept one GPIB byte at a time.  The Bus Monitor window is
automatically open when you start the GPIB analyzer.  Figure 2-3 shows the Bus Monitor
window.

Figure 2-3.  Bus Monitor Window

The ASCII box on the top row displays the current value of the GPIB data lines (8-1) in
ASCII format.  You can enter a printable ASCII character in the ASCII box on the
bottom row to change the settings of the data lines.

The Hex box on the top row displays the current value of the GPIB data lines (8-1) in
hexadecimal format.  You can enter a one-digit or two-digit hexadecimal value in the
Hex box on the bottom row to change the settings of the data lines.

The current value of each GPIB data line is displayed by the LEDs labeled 8 to 1 (where
8 is the most significant bit).  The current value of the GPIB control and handshake lines
is displayed by the LEDs labeled EOI through DAV.  You can monitor these lines, or
you can assert/unassert them by moving the toggle switches.  A line is asserted by the
Bus Monitor when the toggle switch is in the up position.  If the LED for a particular line
is on and the switch for that line is off (down position), the line is asserted, but not by the
Bus Monitor.

Clicking on the Unassert Lines button moves all of the toggle switches to the down
position and disables the Accept Byte button.

Clicking on the Enable Accept Byte button prepares the analyzer to accept either GPIB
data or command bytes, one byte at a time, and changes the button title to Disable Accept
Byte.  The analyzer unasserts NRFD and asserts NDAC.  When another GPIB device on
the bus asserts the DAV signal, click on the Accept Byte button to automatically accept
the byte and prepare to accept the next byte.  Enabling this feature disables the manual
toggle switches for the NRFD and NDAC lines.  When you are finished accepting data,
click on the Disable Accept Byte button to release control of the handshaking lines.

Clicking on the Accept Byte button causes the analyzer to examine the state of the DAV
line to determine whether another GPIB device is trying to source a byte.  If DAV is
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unasserted, clicking on Accept Byte has no effect because no data is available to be
accepted.  If DAV is asserted, clicking on Accept Byte accepts a single byte of GPIB
data by automatically toggling NRFD and NDAC in the proper sequence.  Before you can
use this button, you must click on the Enable Accept Byte button in this window.

Settings Window

The Settings window displays the configuration used by the GPIB analyzer for capturing
and triggering.  The settings only apply to active Capture Display windows when the
control in the Action window is set to Capture or Capture & Trigger.  You cannot
change the settings in this window unless capturing is turned off.

To open the Settings window, choose Change Settings... from the Settings menu in the
Main window.  Figure 2-4 shows the Settings window.

Figure 2-4.  Settings Window

Buffer, Handshaking, and Timestamping Controls

The Retain up to ? capture events field specifies the number of captured GPIB events
that can be kept in the memory buffer at one time.  Once the buffer becomes full, the
oldest GPIB events are discarded to make space for new events.
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Selecting the Participate in Acceptor Handshake checkbox causes the GPIB analyzer
to participate in acceptor handshaking on the GPIB.  You can use this feature to slow
down GPIB transfers to a particular rate or to avoid overflow errors.

The Handshake rate field is used to select the rate at which the GPIB analyzer accepts
data and command bytes.  It is disabled unless the Participate in Acceptor Handshake
box is checked.  The Maximum option allows the analyzer to accept bytes at the fastest
rate possible without causing overflow errors.  The other numeric options slow down all
GPIB transfers to a rate no greater than the rate specified.

Selecting the Enable Timestamping checkbox causes the GPIB analyzer to place a
timestamp on every GPIB event that it captures, starting with a timestamp of zero.

Capture Stimulus Checkboxes

Selecting the Data Transfers checkbox causes the GPIB analyzer to capture all data
bytes transferred on the GPIB.  Both IEEE 488 and HS488 data transfers are captured.

Selecting the Command Transfers checkbox causes the GPIB analyzer to capture all
GPIB command bytes transferred on the GPIB.

Selecting the Control Line Transitions checkbox causes the GPIB analyzer to capture
all transitions of the GPIB control lines.  The control lines are used to manage the GPIB
interface system.

Selecting the Handshake Line Transitions checkbox causes the GPIB analyzer to
capture all transitions of the GPIB handshake lines.  The handshake lines are used to
transfer GPIB data and command bytes.  Because this selection causes a large amount of
GPIB events to be captured, you should select it only when you need to debug a problem
with the handshaking of a particular GPIB device.  Because some handshake line
transitions may fall within the 50 ns resolution of the analyzer, they might be captured
and displayed as a single event when you check this box.

Selecting the Parallel Poll Responses checkbox causes the GPIB analyzer to capture all
GPIB parallel poll responses.  To delimit the beginning of a GPIB parallel poll, the
analyzer captures the assertion of ATN and EOI.  The next capture, after 2 µs, denotes the
beginning of the parallel poll response.  The analyzer then captures data each time the
response on a GPIB data line changes.  To delimit the end of a GPIB parallel poll, the
analyzer captures when ATN and EOI are unasserted.

For more information about setting the capture stimulus, refer to Configure Capture
Settings in Chapter 3, How To.
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Trigger Condition Boxes

The ASCII text box is used to enter a printable ASCII character into the eight data line
list boxes (D8-D1) to the right of this field.  The value is used as a trigger condition when
you select Capture & Trigger in the Action window.  You must enter values for the
control lines and handshake lines separately.

The Hex text box is used to enter a one-digit or two-digit hexadecimal value into the
eight data line list boxes (D8-D1) to the right of this field.  The value is used as a trigger
condition when you select Capture & Trigger in the Action window.  You must enter
values for the control lines and handshake lines separately.

The list boxes D8 through DAV specify the desired state of all GPIB lines for the trigger
condition when you select Capture & Trigger in the Action window.  Each switch has
three possible states:  0 is unasserted, 1 is asserted, and X is don’t care, which means the
line can be asserted or unasserted.

Trigger Settings

The Capture around first trigger point list box specifies whether to stop or continue the
capture, based on the trigger point.  The Capture around first trigger point setting
captures a certain number of events before and after the trigger point, depending on the
placement of the thumb bar below this field.  After the specified number of events are
captured, capturing stops, and the Action window selection changes to Off.  Even if
multiple triggers occur, only the first trigger is used as the point to capture around.
Capture indefinitely after trigger point disables the thumb bar below this field and
allows the oldest captured events to be discarded once the buffer becomes full.

The thumb bar selects the position of the trigger point within a capture.  You can also use
the events before trigger and events after trigger boxes below this field to enter the
desired values.

The events before trigger field specifies the number of GPIB events to be captured
before the trigger condition occurs.  When you enter a number into this field, the value in
the events after trigger field automatically changes so that the total number of captured
events will fit into the buffer.

The events after trigger field specifies the number of GPIB events to be captured after
the trigger condition occurs.  When you enter a number into this field, the value in the
events before trigger field automatically changes so that the total number of captured
events will fit into the buffer.
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The Trigger on first occurrence of condition field selects how trigger points should be
indicated in the Capture Display window.  If Trigger on first occurrence of condition is
selected, only the first occurrence of the specified GPIB event is treated as a trigger point.
If Trigger on all occurrences of condition is selected, every occurrence of the specified
event is considered a trigger point.  Trigger points are enclosed in a dotted rectangle to
distinguish them from other GPIB events.

The Do not sound a beep on any trigger field specifies whether the GPIB analyzer
sounds a system beep at the first trigger event, all trigger events, or not at all.

For more information about setting the trigger conditions, refer to Set Trigger Conditions
in Chapter 3, How To.

Buttons

Clicking on the OK button registers the changes made to the settings in this window, and
then closes the window.  These settings are used the next time you choose the Capture or
Capture & Trigger button in the Action window.  If you want to save these settings to a
file for later use, choose Save Settings As... in the Settings menu of the Main window.

Clicking on the Cancel button cancels the changes made to the settings in this window,
and then closes the window.

Clicking on the Default button changes all of the settings in this window to match the
default values, without closing the window.  If you want to register the default values,
click on the OK button after clicking on Default.

Capture Display Window

The Capture Display window shows the captured GPIB events.  You can have more than
one Capture Display window open at one time, and the capture display can be either
active or inactive.  Active capture displays show GPIB events as they are being captured.
Inactive capture displays show previously captured events statically, so that they are
unaffected by newly captured GPIB events.

To open an active Capture Display window, choose New Capture Display from the File
menu in the Main window.  To open a Capture Display window showing previously
saved GPIB events, choose Open Capture File... from the File menu in the Main
window.  Figure 2-5 shows an example of an inactive Capture Display window.



Chapter 2 GPIB Analyzer Windows

© National Instruments Corp. 2-9 GPIB Analyzer User Manual

Figure 2-5.  Capture Display Window

Menus

Choosing Save As... from the File menu allows you to save the GPIB events in the
capture display to a file.  Both inactive and active (if capturing is turned off) files can be
saved.  Whenever possible, use the .CAP extension for GPIB analyzer capture files.

Choosing Print... from the File menu allows you to print the contents of an inactive
capture display to a selected printer.

Choosing Export... from the File menu allows you to save the GPIB events in an inactive
capture display in an ASCII text file, which can be imported into other applications such
as word processors.  You cannot import the ASCII file back into the GPIB analyzer.

Choosing Close... from the File menu allows you to close the Capture Display window.
The analyzer program prompts you to save any unsaved GPIB events.

The Help menu accesses the online help system for the GPIB analyzer.
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Capture Settings

The Stimulus field lists the Capture Stimulus (from the Settings window) used when
the GPIB events in the capture display were captured.

The Capture size field lists the value of the Retain up to ? capture events field (from
the Settings window) used when the GPIB events in the capture display were captured.

The Handshake rate field lists the value of the Handshake rate (from the Settings
window) used when the GPIB events in the capture display were captured.  If the
Participate in Acceptor Handshake checkbox was not selected in the Settings window,
this field displays None.

Markers & Statistics

The From box is used to select the beginning marker used to calculate the statistics
shown below this field, such as the number of events captured between selected markers,
the time elapsed between selected markers, and the number of capture events per second.

The To box is used to select the ending marker used to calculate the statistics shown
below this field, such as the number of events captured between selected markers, the
time elapsed between selected markers, and the number of capture events per second.

The Go To field allows you to go to a particular marker in the capture display.

The Number of capture events statistic displays the number of GPIB capture events
contained between the markers indicated in the From and To entries above, including the
markers themselves.

The Time elapsed statistic displays the elapsed time between the markers indicated in the
From and To entries above.

The Capture events per second statistic displays the rate at which the indicated GPIB
events occurred, which is determined by dividing the time elapsed by the number of
events minus one.

Buttons and Display Mode

Clicking on the Find... button opens the Find window, which is used to specify search
criteria for finding a particular GPIB event in an inactive capture display.

Clicking on the Find Next button causes the analyzer to search for the next occurrence of
your search criteria in the capture display.  This button is disabled if you have not yet
entered your search criteria in the Find window.
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Clicking on the Switch to Active/Inactive Display button switches you between active
and inactive capture display modes.  Active capture displays show GPIB events as they
are being captured.  Inactive displays show previously captured GPIB events.  With
inactive displays, you can place markers, view statistics about the captured GPIB events,
and search for specific GPIB events.  Switching from inactive to active erases all
captured GPIB events and markers, but the analyzer prompts you to save your data before
switching to active display.

The Display mode box shows the display mode used for the captured GPIB events.  With
detailed display mode, captured GPIB events are shown one per line.  In summarized
display mode, multiple events can be shown on each line.  Line transitions are displayed
on separate lines, but data and command transfers are grouped on the same line.  In both
display modes, data transfers are shown in blue, command transfers are shown in green,
and control line transitions, handshake line transitions, and parallel poll responses are all
shown in black.

Display Fields

The dark column heading field under the buttons and Display mode box shows the titles
of the columns of data in the capture display field.

The capture display field shows captured GPIB events, markers, timestamps, and helpful
mnemonics.  It can also show control line and handshake line transitions.  If the line name
is followed by an up arrow, the line went from unasserted to asserted.  If the line name is
followed by a down arrow, the line went from asserted to unasserted.  This field might
also display an overflow error message if the FIFO is full and events are lost.

For specific information about how to interpret the capture display, refer to the section
Read the Capture Display in Chapter 3, How To, or Appendix C, Capture Display
Mnemonics.
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Find Window

The Find window allows you to specify criteria and search for a specific GPIB event in a
capture display.

To open the Find window, click on the Find button in the Capture Display window.
Figure 2-6 shows a sample Find window.

Figure 2-6.  Find Window

Input Bus State

The ASCII field displays the current search value of the GPIB data lines (D8-D1) in
ASCII format.  You can enter a printable ASCII key sequence in this field to change the
search criteria for the data lines.

The Hex field displays the current search value of the GPIB data lines (D8-D1) in
hexadecimal format.  You can enter a one-digit or two-digit hexadecimal value in this
field to change the search criteria for the data lines.
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The current search value of each GPIB data line is displayed by the list boxes labeled D8
to D1 (where 8 is the most significant bit).  The current search value of the GPIB control
and handshake lines is displayed by the list boxes labeled EOI through DAV.  You can
assert/unassert the lines by moving the toggle switches.  Each switch has three possible
states:  0 is unasserted, 1 is asserted, and X is don’t care, which means the line can be
asserted or unasserted.

Find Specifications

The Find String field shows the entered search criteria as a string of GPIB bus states.  If
you click on a specific bus state, that bus state is highlighted.  It appears in the Input Bus
State field and can be changed there.  When a bus state is highlighted, you can use the
Insert Above or Insert Below buttons to  insert a new GPIB bus state, which appears
with don’t care (X) bits until you highlight the bus state and change it.  You can also
delete a bus state using the Delete button.

The Search Direction switch specifies the direction to search from the current cursor
position in the capture display.

Selecting the Find Trigger checkbox causes the search to locate the nearest trigger
condition in the capture display.

Buttons

Clicking on the Insert Above button inserts a new GPIB bus state above the highlighted
bus state.  Newly inserted bus states are initialized to don’t care (X) bits until you change
them.

Clicking on the Insert Below button inserts a new GPIB bus state below the highlighted
bus state.  Newly inserted bus states are initialized to don’t care (X) bits until you change
them.

Clicking on the Delete button deletes the highlighted bus state from the search criteria.

Clicking on the Find button registers the search criteria and closes the Find window.
When you return to the capture display, the cursor will be on the nearest GPIB event
matching the search criteria.

Clicking on the Cancel button cancels the search criteria and closes the Find window.
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Chapter 3
How To
                                                                                                                                                   

This chapter describes how to accomplish specific tasks within the GPIB analyzer
application.

Start and Stop

To begin capturing data, first choose the capture settings and trigger conditions you want
to use from the Settings window.  If an active capture display is not already open, choose
to open a new Capture Display window using the File menu of the Main window.  Then
click on the Capture or Capture & Trigger button in the Action window to begin
capturing and displaying data.  You can also use the <F6> or <F7> keyboard commands.
To stop capturing new data, click on the Off button in the Action window or press <F5>.

To exit the GPIB analyzer, choose Exit from the File menu in the Main window.  The
program prompts you to save any Capture Display window that contains unsaved GPIB
events.  The current capture and trigger settings are automatically saved and will be
loaded the next time you open the analyzer.

Monitor or Participate in GPIB Activity

View/Change the State of GPIB Lines

You can view or change the state of the GPIB data and control lines within the Bus
Monitor window.  The LEDs show the current state of the GPIB lines.  The toggle
switches show whether the lines are asserted by the Bus Monitor.

To assert a value on the GPIB data lines (8-1), you can enter a printable ASCII value in
the ASCII box on the bottom row, enter a one-digit or two-digit hexadecimal value in the
Hex box on the bottom row, or manually toggle the data line switches.  A line is asserted
when the switch is in the up position and shows a binary value of 1.  After you set your
data lines to the desired positions, use the DAV switch to source the data byte on the bus.

To change the GPIB control lines (EOI, ATN, SRQ, REN, and IFC) and handshake lines
(NRFD, NDAC, and DAV), change the position of the toggle switches.  A line is asserted
when the switch is in the up position and shows a binary value of 1.

To accept a byte of data on the bus, use the NRFD and NDAC switches or use the
Accept Byte button, which automatically toggles these switches in the correct sequence.

If you are using the Bus Monitor to assert GPIB lines, do not use the NI-488.2 ibfind
function.  This function will unassert the lines on the bus, even though the switches in the
Bus Monitor window show that the lines are asserted.  If you encounter this problem,
click on the Unassert Lines button and avoid using the ibfind function.
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Accept a Single Byte

To accept a single byte of data on the GPIB, first click on the Enable Accept Byte button
in the Bus Monitor window.  Then click on the Accept Byte button in the Bus Monitor
window.  This action automatically toggles the NRFD and NDAC lines in the correct
handshaking sequence to accept a single byte.  If you disable the Accept Byte feature,
you can control the NRFD and NDAC lines manually using the toggle switches in the
Bus Monitor window.

If you try to accept a byte when no GPIB device is currently trying to source a byte (DAV
unasserted), then toggling the handshake lines or clicking on Accept Byte has no effect.

Capture and Display Data

To capture and display new data, first select the capture settings and trigger conditions
you want using the Settings window.  If an active capture display is not already open,
choose to open a new Capture Display window using the File menu of the Main window.
When you are ready to begin the capture, click on the Capture or Capture & Trigger
button in the Action window.  You can also use the <F6> or <F7> keyboard commands
to start your capture.  If you want to monitor GPIB activity while running another GPIB
application, start your application after you begin the capture.

Capture displays can be active or inactive.  Active displays have the title “Active Capture
Display: X” and show GPIB events as they are being captured.  Inactive displays show
previously captured events and allow you to analyze the data.  You can switch back and
forth between active and inactive by clicking on the Switch to Active/Inactive Display
button in the Capture Display window.

To open a Capture Display window showing previously saved GPIB events, choose
Open Capture File... from the File menu in the Main window.

Note the following capabilities concerning the capture display:

• You can switch from Capture to Capture & Trigger during the capture without
losing data.

• The maximum rate at which the analyzer can capture GPIB events is once every
50 ns.

• You can view more than one capture display at a time.

Configure Capture Settings

To configure the capture settings, first make sure that capturing is turned off in the Action
window.  Then open the Settings window by selecting Change Settings... from the Main
window Settings menu, and select the configuration that you want to use.  When you are
finished making changes, click on OK in the Settings window.  You can also save and
reload your capture settings.
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Capture Stimulus Choices

You may want to limit your capture stimulus to certain types of events.  You can capture
any combination of data transfers, command transfers, control line transitions, handshake
line transitions, and parallel poll responses.  You might want to choose only the types of
events you need, to avoid overflow errors.  In particular, capturing handshake line
transitions causes a high volume of capture events and takes more processor time.  In the
Capture Stimulus section of the Settings window, select the checkboxes for the types of
events you want to capture.

Buffer Setting

In the Settings window, you can set the Retain up to ? capture events option to specify
the maximum number of capture events that are retained in the buffer.  When the buffer
becomes full, the oldest GPIB events are discarded to make room for new events.

Handshake Settings

If you want to slow down GPIB transfers, select the Participate in Acceptor Handshake
checkbox and choose a rate with the Handshake rate field.

Timestamping Feature

If you want to use the timestamping feature, select the Enable Timestamping checkbox
in the Settings window.

Set Trigger Conditions

To set the trigger conditions for your capture, first make sure that capturing is turned off
in the Action window.  Then set the criteria in the Trigger Condition section of the
Settings window.

In the Trigger Condition section of the Settings window, enter the bus state you want to
trigger on using the ASCII box, Hex box, or individual switches for each line.  If you
want to set a trigger condition for a data byte, set the data lines to that byte, ATN to
unasserted (0), DAV to asserted (1), NDAC to 1, NRFD to 0, and all other lines to don’t
care (X).  If you want to set a trigger condition for a command byte, set the data lines to
that byte, ATN to asserted (1), DAV to asserted (1), NDAC to 1, NRFD to 0, and all
other lines to don’t care (X).  If you want to set the trigger condition for any control line
or handshake line event, set the line to that state and set all other lines to don’t care (X).

Use the fields in the Settings window under the Trigger Condition section to set the
other trigger condition options.
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When you are finished making changes, click on OK in the Settings window.  You can
also save and reload your trigger settings.  To trigger on a certain event that you have
specified, choose Capture & Trigger in the Action window.

Timestamp Capture Events

To enable timestamping, select the Enable Timestamping checkbox in the Settings
window.  Timestamping shows you the elapsed time from the first GPIB event on the
previous line to the first GPIB event on the timestamped line.  The timestamp information
appears in the timestamp column of the capture display.  Timestamping allows you to
calculate statistics in the Capture Display window.

Do a Non-Intrusive Capture

To prevent the GPIB analyzer from participating in acceptor handshaking, unselect the
Participate in Acceptor Handshake checkbox in the Settings window.  If this checkbox
is selected, the analyzer participates in all acceptor handshaking that occurs on the GPIB.
You might want to select this checkbox to slow down the GPIB transfers or to avoid
overflow errors.

Avoid Overflow Errors

An overflow error occurs when the FIFO hardware buffer fills up with GPIB events faster
than the software can receive them.  If this happens, an error message with asterisks and
the word “OVERFLOW” appears in the capture display.  If an overflow error occurs, one
or more GPIB events have been lost.  You can usually avoid overflow errors by making
one of the following changes:

• Select the Participate in Acceptor Handshake checkbox in the Settings window,
and set the Handshaking rate to Maximum.  This configuration causes the analyzer
to hold off when the FIFO is almost full.  It prevents high speed GPIB data transfers
when the FIFO is almost full, which can be a common cause of overflow errors.

• Unselect the Handshake Line Transitions checkbox in the Settings window.  If this
option is selected, you might capture up to six times as many GPIB events as
choosing to capture only data and command transfers.  This high volume of events is
likely to cause overflow errors.

• Unselect the Enable Timestamping checkbox in the Settings window.  If you do not
need to see the timestamping information, disabling this option can reduce the
amount of data transferred from the FIFO and reduce the possibility for overflow
errors.
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• Unselect the Control Line Transitions checkbox in the Settings window.  Some
GPIB devices may toggle the control lines incorrectly, and overflow errors could
result.

• Close all active capture displays while capturing.  The analyzer captures GPIB events
more efficiently if they do not need to be displayed immediately.

• Increase the Retain up to ? capture events value in the Settings window.  This field
specifies the maximum number of capture events retained in the capture buffer.

Save and Reload Capture/Trigger Settings

The analyzer uses the current capture and trigger settings until you change them again
and automatically saves them when you exit the analyzer program.  If you want to save
the current settings for later use before you try new settings, select Save Settings As...
from the Settings menu in the Main window.  Whenever possible, use the .SET
extension for analyzer settings files.

If you want to load a file of previously saved settings, select Load Settings... from the
Settings menu in the Main window.  Then choose Change Settings... from the same
menu to view or change those settings.

Analyze Captured Data

After you have captured GPIB events, you are ready to read and interpret the capture
display, calculate statistics, search for capture events, print the file, or save the file.

Read the Capture Display

You can view the captured GPIB events in either detailed display mode or summarized
display mode.  With detailed display mode, captured GPIB events are shown one per line.
In summarized display mode, multiple events can be shown on each line.  Line transitions
are displayed on separate lines, but data and command transfers are grouped on the same
line.  In either display mode, lines are colored based on the type of event captured.
Table 3-1 lists the display colors.
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Table 3-1.  Colors in the Capture Display Window

Type of Event Color

Data transfers Blue

Command transfers Green

Control line transitions Black

Handshake line transitions Black

Parallel poll responses Black

Trigger event Dotted box

Timestamp Column

In detailed mode, where each line can correspond to only one capture event, the
timestamp value represents the time elapsed between the event on that line and the
previous event.  So if you want to determine the time elapsed between the capture of the
first event and the fifth event, add up the timestamp values on the second, third, fourth,
and fifth lines.

In summarized mode, where more than one event can be present on a line, the timestamp
value represents the time elapsed between the first event on that line and the first event on
the previous line.

The timestamp column in the capture display shows the timestamp in minutes, seconds,
milliseconds, microseconds, and nanoseconds.  If the timestamp exceeds 60 minutes, the
timestamp is shown in hours, minutes, and seconds.  The abbreviations used for the
various time scales are listed in Table 3-2.  The smallest resolution possible for any
timestamp is 50 ns.

Table 3-2.  Timestamp Abbreviations in the Capture Display Window

Time Unit Abbreviation

Nanoseconds ns

Microseconds us

Milliseconds ms

Seconds s

Minutes mi

Hours hr
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Mnemonics Column

Various mnemonics appear in the right column of the capture display to provide a quick
interpretation of the captured GPIB events.  The column may also show line transitions.
If the line name is followed by an up arrow, the line transition occurred from unasserted
to asserted.  If the line name is followed by a down arrow, the transition occurred from
asserted to unasserted.  Note that if the analyzer is capturing handshake line transitions,
the assertion of DAV represents a GPIB data byte or command byte.  For a detailed list of
the mnemonics and their meanings, refer to Appendix C, Capture Display Mnemonics.

Search for a Capture Event

To search for a specific GPIB event within a capture display, first make sure that you
have switched to an inactive Capture Display window.  Then click on the Find button in
that window.  Clicking on the Find button opens the Find window.  Use the Find window
to enter your search criteria, or a string of events to search for, and then click on the Find
button in that window.  This action automatically closes the Find window and returns you
to the nearest GPIB event in the Capture Display window that matches your criteria.  To
find the next occurrence of that event, click on the Find Next button.

Mark Capture Events to Show Statistics

You can add markers only to inactive Capture Display windows.  All inactive capture
displays contain at least two markers: begin and end.  If you click once on an event in the
capture display, a cursor appears there.  To add a permanent marker to a line, double-click
on that line.  The first marker you set is labeled M0 in the marker column of the capture
display.  The next appears as M1, and so on.  To delete a marker, double-click on the
GPIB event again.

If you are using summarized display mode, you might have more than one marker for
each line.  In this case, the letter “M” appears in the marker column.  You can click on the
“M” several times to see each marker for that line.

Print and Save

To print the contents of an inactive Capture Display window, choose the Print command
from the File menu in the Capture Display window.  You can also print only selected
capture events in an inactive display.

Both inactive and active (if capturing is turned off) capture displays can be saved to a file.
To save the data in a Capture Display window, choose Save As... from the File menu in
the Capture Display window.  Whenever possible, use the .CAP extension for saving
capture display files.  Captured data is saved in an analyzer-specific format and can be
reopened as an inactive capture display.
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You can also export an inactive capture display to another application, such as a word
processor.  Choosing Export... from the File menu of the Capture Display window saves
the data as an ASCII text file that you can open in another program.  You can save
captured data as text in both detailed and summarized formats.
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Chapter 4
Tutorial
                                                                                                                                                 

This chapter contains a hands-on tutorial to help you practice using the different features
of the GPIB analyzer.

Before you start the tutorial, check the following:

• Make sure that the NI-488.2 software, GPIB analyzer software, and GPIB analyzer
hardware are installed on your computer.  For installation instructions, refer to your
getting started manual.

• Disconnect all GPIB cables from your GPIB hardware.

Part 1: Capture and View New Data

1. Open the GPIB analyzer.  To open the analyzer application in Windows 95, click the
Start button and select Programs.  From this list, select the GPIB Analyzer for
Windows 95 folder.  In this folder, select the GPIB Analyzer.

To open the analyzer application in Windows 3.1, double-click on the GPIB
Analyzer icon, which is located in the GPIB Analyzer Software group in the
Program Manager.

When you open the analyzer application, you will see the Main window, which
contains the Bus Monitor window and Action window.  A new Capture Display
window also opens.

2. From the  Settings menu, choose Change Settings to access the Settings window.

3. Click on the Default button to reset the screen to the default settings.

4. In the Capture Stimulus section, choose to capture the following stimuli:  data
transfers, command transfers, control line transitions, and parallel poll responses.  Do
not select handshake line transitions.

5. Click in the Retain up to ? capture events box and change the setting to 60,000
capture events.

You do not need to change the trigger pattern for this part of the tutorial.  Since you
are not yet looking for a specific trigger pattern, the other trigger settings will have
no effect.
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The Settings window should now look like the following screen.

6. Click on OK to use these settings.

You could save these settings to use at a later time.  To save them, you would choose
Save Settings As... from the Settings menu in the Main window.  To retrieve the
settings, you would choose Load Settings from the same menu.

7. If you cannot see the Action window, bring it to the front by choosing Action
window from the Windows menu of the Main window.  A picture of the Action
window follows.

8. Click on the Capture button in the Action window.  The analyzer is ready to capture
GPIB events.

9. Open the Interactive Control utility.  If you are using Windows 95, do not quit the
analyzer program, but click the Start button, select the Programs menu, and open
the NI-488.2M Software for Windows 95 folder.  Then select the Win32
Interactive Control utility.



Chapter 4 Tutorial

© National Instruments Corp. 4-3 GPIB Analyzer User Manual

If you are using Windows 3.1, do not quit the analyzer program, but switch to the
Program Manager and open the Win16 Interactive Control utility by
double-clicking on its icon in the NI-488.2 Software group.

10. At the prompt, enter $ c:\gpibanlz\tutorial.txt to run the tutorial script.
(The path to the file may be different if you did not use the default installation for the
analyzer software.)  Wait until the script has executed.  The NI-488.2 commands in
this script file write data on the GPIB, and the analyzer portion of the GPIB hardware
captures the data.

11. At the : prompt, type quit and press <Enter> to exit the interactive control utility.

12. Switch back to the GPIB analyzer program, and click Off in the Action window to
stop the capture.

13. Bring the active Capture Display window to the front by clicking on it, and use the
scroll bar to go to the beginning of the capture file.

The Capture Display window should look something like the following screen.

By default, the capture display is in detailed mode, which shows one GPIB event per
line.  This mode shows the greatest amount of detail, including the status of each
GPIB line and helpful mnemonics.  In this display, you can see that the tutorial script
file completed the following commands:  cleared the GPIB interface, addressed a
device to listen, and wrote ASCII data to the device.
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14. Change the display mode from detailed to summarized by clicking on the arrow
beside the Display Mode box.  Summarized display mode is often easier to read if
you do not need to see one event per line, but it does not show as much information.

Part 2: Capture and View New Data with a Trigger Condition

1. From the Settings menu in the Main window, choose Change Settings to bring up
the Settings window.

2. In the Capture Stimulus section, choose to capture data transfers and command
transfers.  Unselect the checkboxes for the other types of transfers.  This will restrict
the analyzer to capture only data and command transfer events on the bus.

3. Click on “Maximum” in the Handshake rate box to see your choices.  Then click on
the 1 Kbyte/s option.  This handshake rate will slow down the GPIB transfers.

4. Choose to retain up to 50 capture events.

5. Select the Enable Timestamping box to turn on the timestamping feature.

6. In the Trigger Condition section, enter “1” in the ASCII box and notice the
corresponding changes in the Hex box and the D8-D1 toggle switch boxes.

7. Use the toggle switches to set the ATN line to 0, NRFD to 0, NDAC to 1, and
DAV to 1.  Leave the EOI, SRQ, REN, and IFC lines set as don’t care (X).

8. Make sure Capture around first trigger point shows up as the current setting.  This
option stops the capture when a certain number of events have been captured after
the trigger point.  It allows you to specify how many events to capture before and
after the trigger point.

9. Move the thumb bar pointer so that the capture file will show 5 events before the
trigger point and 44 events after the trigger point.

10. Click in the box with the words Trigger on first occurrence of condition to see
your choices.  Select Trigger on all occurrences of condition.  This option captures
and displays all occurrences of the trigger condition.

11. Click in the box with the words Do not sound a beep on any trigger to see your
choices, then select Sound a beep on first trigger point.
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The Settings window should look like the following screen.

12. Click on OK to use these settings.

13. Bring the Action window to the front by choosing Action window from the
Windows menu.  Click on the Capture & Trigger button.  The analyzer is ready to
capture data and look for the trigger condition specified in the Settings window.

14. Bring the Capture Display window to the front, and notice that the changes you made
in the Settings window are shown in the Capture Settings section since you clicked
on Capture & Trigger.

15. Open the Interactive Control utility.  If you are using Windows 95, do not quit the
analyzer program, but click the Start button, select the Programs menu, and open
the NI-488.2M Software for Windows 95 folder.  Then select the Win32
Interactive Control utility.

If you are using Windows 3.1, do not quit the analyzer program, but switch to the
Program Manager and open the Win16 Interactive Control utility by
double-clicking on its icon in the NI-488.2 Software group.

16. At the prompt, enter $ c:\gpibanlz\tutorial.txt to run the tutorial script
again.  (The path to the file may be different if you did not use the default installation
for the analyzer software.)  Wait until the script has executed.  The NI-488.2
commands in this script file write data on the GPIB, and the analyzer portion of the
GPIB hardware captures the data.
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17. At the : prompt, type quit and press <Enter> to exit the interactive control utility.
Switch back to the analyzer program.

18. Click on Off in the Action window, then bring the active Capture Display window to
the front.

19. Click on Switch to Inactive Display, and choose detailed display mode.  Scroll to
the top of the display file.

The Capture Display window should look something like the following screen.

The trigger points are enclosed in dotted boxes and the display shows five events
before the first trigger point.

20. Choose Save As... from the File menu in the Capture Display window, which is
shown in the following picture.
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21. Enter tutor2.cap as the filename and click on Save.  Notice that tutor2.cap
appears on the title bar of the Capture Display window.

22. From the  File menu in the Main window, choose Exit to quit the analyzer
application.

Part 3: Search for Data in a Capture Display

1. Open the GPIB analyzer application.

2. From the File menu of the Main window, choose Open Capture File.

3. In the dialog box, enter tutor2.cap to retrieve the capture file that you saved in
part 2 of this tutorial, and click on OK.  The capture file is automatically opened as
an inactive display.

4. Click on the Find... button in the Capture Display window to bring up the Find
window.

5. Select the Find Trigger checkbox to search for the captured trigger event, ASCII 1,
which was the trigger point specified in part 2 of this tutorial.  The trigger pattern
appears in the Input Bus State field and the Find String field.

6. Click on Find to start the search.  The result will be highlighted as shown in
following screen.  ASCII 1 appears in the “A” column of the highlighted row.
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7. Click on the Find... button again to return to the Find window.

8. Unselect the Find Trigger checkbox.

9. In the Input Bus State section, enter “5” in the ASCII box.

10. Click on Find to locate the search pattern.

11. Return to the Find window and choose Insert Below to enter another pattern in the
Input Bus State.

12. Enter “6” in the ASCII box to indicate the second pattern in the search.

13. Insert another line below, but this time enter “7”.  These characters form a string that
the analyzer will search for in the capture file.  The Find window should look like the
following screen.

14. Click Find to search for the string “567”.
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15. The first character of the search string, “5”, will be highlighted as shown in the
following screen.

16. Click on the Find Next button to continue your search.  The next successful search
result will be highlighted.

Part 4: Show Statistics for Captured Data

Use the tutor2.cap capture file that you obtained in part 2 of this tutorial.

1. In the Capture Display window create a marker at the line containing the ASCII
character “A” by double-clicking on that line.  The marker M0 appears in the marker
column of that line.

2. Create another marker at the line containing the letter “Z”.  M1 appears in the marker
column of that line.

3. Click on the word Begin in the From list box to see your choices, then select M0,
the marker for the letter “A”.

4. Choose M1 for the To list box.

The analyzer calculates and displays statistics as shown in the following screen.
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The capture display statistics show the total number of captured events from marker
M0 to marker M1.  The Time elapsed statistic shows you the total time to transfer
this block of data.  The Capture events per second box shows system performance
during this period of time.

5. Choose M0 in the Go To list box to highlight the line with the letter “A” again.

Part 5: Print and Export a Capture File

This part of the tutorial is continued from part 4.  Use the tutor2.cap capture file that
you used in part 4.

1. Choose Print... from the File menu of the Capture Display window.

2. In the print dialog box, select M0 for the From Marker and M1 for the To Marker.

3. Click on OK.  The portion of the capture display from M0 to M1 will be printed.  If
you want to print the entire capture display, choose Begin for the From Marker and
End for the To Marker.

4. Save the capture file as ASCII text by choosing Export... from the File menu in the
Capture Display window.
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5. Enter sample.txt in the export dialog box, and click on Save.  You can view the
exported file in a text editor, but you cannot import it back to the analyzer.

6. From the File menu in the Main window, choose Exit to quit the analyzer
application.
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Chapter 5
Examples
                                                                                                                                                 

This chapter contains several case scenario examples to show you how you might use the
analyzer to solve your IEEE 488 problems.

Example 1:  Slow Communication

Description of Problem

A technician is running a GPIB application program in which an AT-GPIB/TNT+ board
is communicating with a multimeter.  In the application, the Controller instructs the
instrument to reset to its default settings, measure Ohms, and return a reading.  The
application seems to be running slowly, and the technician wants to determine the cause
of the slow performance.

Setting up the GPIB Analyzer

By using the timestamping feature of the GPIB analyzer, the technician can determine
what is causing the application to run slowly.  In the Settings window of the GPIB
analyzer, he chooses the following settings:

• Capture data transfers, command transfers, and control line transitions

• Retain 10,000 events

• Timestamping feature enabled

• Do not participate in acceptor handshake
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The Settings window looks like the following screen.

The technician chooses Capture in the Action window and runs his application program.
After the program executes, he switches back to the analyzer and chooses Off in the
Action window.
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Reading the Capture Display

The following picture shows the resulting capture display.

The technician has chosen summarized display mode.  In the capture display, he sees the
string “RST; OHMS; VAL1?”, which instructs the multimeter to reset, measure Ohms,
and send a reading to the Controller.  The next string, “+150.38E+0” is the reading from
the device.  The technician switches back to detailed display, and after he places the
markers in the capture display, he selects various markers in the From and To list boxes.
For example, he calculates the time the device takes to start sending its measurement,
which is 1 s, 81 ms, 429 µs, and 450 ns.  The statistics that the technician sees reveal that
the system performance is satisfactory, but the instrument is slow in returning a
measurement.

Example 2:  A Service Request Problem

Description of Problem

A test engineer has a GPIB system with two GPIB devices connected.  The engineer
expects that when a device requests service, it asserts the SRQ line.  He has specified in
his application program that when SRQ is asserted, the Controller serial polls the active
devices to determine which device is requesting service and then takes the appropriate
action.  In this particular program, the time between the device asserting SRQ and the
device receiving service is too long, so the engineer wants to check the SRQ and serial
poll response of his system.
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Setting up the GPIB Analyzer

By using the timestamping feature of the GPIB analyzer, the engineer is able to view the
service request process and measure response times.  He configures the analyzer to
trigger at the assertion of SRQ and to capture GPIB events afterwards.  By observing the
captured events with timestamping information, he learns more about the sequence of
events during a serial poll of his system.

In the Settings window of the GPIB analyzer, the engineer chooses the following settings:

• Capture data transfers, command transfers, and control line transitions

• Capture 500 events after the trigger point

• Trigger condition set to SRQ asserted (SRQ = 1) and all other lines equal to “X”

• Timestamping feature enabled

• Capture around the first trigger point

The Settings window looks like the following screen.

The engineer chooses Capture & Trigger in the Action window and runs his application
program.
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Reading the Capture Display

The following picture shows the resulting capture display.

The marker M0 appears on the first line, which shows the assertion of the SRQ line.  The
engineer places a marker M1 where the Controller starts the serial poll by sending the
Unlisten command (UNL).  By choosing M0 in the From list box and M1 in the To list
box to calculate the Time elapsed statistic, he sees that the Controller takes 851 ms,
449 µs, and 200 ns to respond to the serial poll.

The Controller sends its listener address (LA0 in this case) and the serial poll (SPE).  The
Controller sends TA1 so that the first device can talk, then unasserts ATN and reads the
status byte (0x00) from the device.  By reading the timestamp information on the line
where the first device sends 0x00, the engineer knows that the device takes 103 ms, 3 µs,
and 40 ns to send its status byte.

Because the first device is not the one requesting service, the Controller addresses the
second device to talk.  The Controller then reads the device’s status byte (0x40), which
indicates that it is requesting service.  By reading the timestamp information on the line
where the second device sends 0x40, the engineer sees that the device takes only 1 µs and
50 ns to send its status byte.
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Because the response time of the second device polled is shorter than the first device, the
engineer changes his application so that the Controller always polls the faster device first.
If the faster device is the one requesting service, the Controller will not need to poll the
slower device.

Example 3:  Device Not Responding

Description of Problem

A programmer has written a GPIB application program, but her device is not responding
to the program.

Setting up the GPIB Analyzer

The programmer configures the analyzer so that she can check for communication
problems.  In the Settings window of the GPIB analyzer, she chooses the following
settings:

• Capture data transfers, command transfers, and control line transitions

• Retain 60,000 events

• Participate in handshaking and transfer rate set to maximum

• Timestamping disabled

The Settings window looks like the following screen.
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The programmer chooses Capture in the Action window and captures the sequence of
events on the bus.  She then clicks on Off in the Action window of the analyzer.

Reading the Capture Display

The resulting capture display looks like the following screen.

In this example, the Controller does not seem to be sending any data bytes.  In her
application program, the programmer set up the device to have primary address 3 and
secondary address 96.  She notices, however, that at the line containing the marker M0,
the Controller configures the device to be a Listener at primary address 3 with no
secondary address.  The device is not responding because the Controller is not addressing
it correctly.  The programmer corrects her application and runs the capture again.  The
Controller can now write to the device, and the capture display looks like the following
screen.
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Example 4:  Timeout Error During a Read

Description of Problem

A programmer’s application returns a timeout error while waiting to receive data from a
device.

Setting up the GPIB Analyzer

The programmer configures the analyzer so that he can examine the GPIB activity during
a read from the device.  In the Settings window of the GPIB analyzer, he chooses the
following settings:

• Capture data transfers, command transfers, and control line transitions

• Retain 60,000 events

• Participate in handshaking and transfer rate set to maximum

• Timestamping disabled
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The Settings window looks like the following screen.

The programmer chooses Capture in the Action window and captures the sequence of
events as the device sends data on the bus.  He then clicks on Off in the Action window
of the analyzer.
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Reading the Capture Display

The resulting capture display looks like the following screen.

This capture display shows that the device asserts EOI with the last byte.  The
programmer remembers that he set up his application to expect an End-of-String
character to terminate the data transfer from the device.  He changes the program so that
it expects the assertion of EOI to terminate the data transfer.  The application then runs
without an error.
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Appendix A
Common Questions
                                                                                                                                                 

This appendix answers common questions about the GPIB analyzer.

Why can’t I use the analyzer to monitor a GPIB application which uses the NI-488.2
ibln or FindLstn command?

You can use the analyzer to monitor an application with these commands, but you cannot
select Participate in Acceptor Handshaking in the Settings window.  Selecting this
feature asserts/unasserts the NDAC and NRFD lines in response to the Talker’s
assertion/unassertion of DAV in the GPIB handshake sequence.  Therefore, when you run
an application that executes a FindLstn or ibln command, all possible GPIB
addresses are returned.

How does selecting “Participate in Acceptor Handshake” in the Settings window
affect the GPIB?

When Participate in Acceptor Handshake is selected, the analyzer circuitry behaves
like a GPIB Listener for the duration of the capture and participates in acceptor
handshaking on the GPIB.  You can use this feature to slow down GPIB transfers to a
particular rate and to avoid overflow errors.

How do I choose a handshake rate?  What does “Maximum” mean?

You can use the handshake rate to slow down the transfer rate on the GPIB while
debugging timing-related problems.  Choosing a particular handshake rate guarantees that
the transfer rate on the bus will be less than or equal to that rate.  Choosing the
Maximum rate causes the analyzer to respond as a Listener as fast as it can without
causing overflow errors.

How do I define a trigger point to capture a command byte such as TA0?

In the Settings window, set the data lines of the trigger condition by entering either the
ASCII or hex equivalent of TA0 or set each of the data lines independently to represent
TA0.  Set the ATN, DAV, and NDAC lines to 1.  Set NRFD to 0.  The remainder of the
control lines should be set to X.  This state of the handshake lines is necessary to
guarantee that valid data is present on the data lines.
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What do the rows of lights and switches in the Bus Monitor window represent?

The LEDs represent the state of the bus lines at all times.  The toggle switches represent
the assertion of lines from within the Bus Monitor window of the analyzer.  So if the LED
for a particular line is on, and the switch for that line is off (down position), the line is
asserted, but not by the Bus Monitor.

What is the difference between an active and inactive Capture Display window?

Active capture displays show GPIB events as they are being captured.  In other words,
active capture displays are windows into the single capture buffer used to store new GPIB
events.  Inactive capture displays show previously captured GPIB events statically, so
that they are unaffected by newly-captured GPIB events.  You must make the capture
display inactive if you want to use the search or print features.

What do the “Capture Settings” in the Capture Display window mean?

The Capture Settings section of the Capture Display window shows the capture settings
that were used when the data in the window was captured.  They help you interpret the
captured data in the Capture Display window.  They are not necessarily the same as the
current capture settings.

How do I use the timestamping information in detailed display mode and
summarized display mode?

In detailed display mode, where each line can correspond to only one capture event, the
timestamp value represents the time elapsed between the event on that line and the
previous event.  So if you want to determine the time elapsed between the capture of the
first event and the fifth event, add up the timestamp values on the second, third, fourth,
and fifth lines.

In summarized display mode, where more than one event can be present on a line, the
timestamp value represents the time elapsed between the first event on that line and the
first event on the previous line.

How can I prevent overflow errors?

For detailed information about avoiding overflow errors, refer to the Avoid Overflow
Errors section in Chapter 3, How To.

What information should I have before I call National Instruments?

Before you call National Instruments, make sure you have filled out the configuration
form in Appendix D, Customer Communication.
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Appendix B
Keyboard Commands
                                                                                                                                                 

This appendix lists keyboard shortcuts that you can use within the GPIB analyzer.

You can use the following keyboard commands from anywhere in the GPIB analyzer
application.

<Alt-F4> Exit the GPIB analyzer
<Ctrl-F4> Close the current window
<Ctrl-Esc> Switch to another application
<F1> Access online help system
<Ctrl-N> Bring up a new Capture Display Window
<Ctrl-O> Open a capture file as a Capture Display Window
<Ctrl-T> Change the settings
<Ctrl-S> Save the foremost Capture Display Window
<Ctrl-P> Print the foremost Capture Display Window
<F5> Turn off capture and trigger
<F6> Start capture
<F7> Start capture and trigger

You can use the following keyboard commands to move the cursor and make selections.

<Tab> Move to the next control item
<Shift-Tab> Move to the previous control item
<Space> Select (equivalent to mouse click except in open list box)
<Down Arrow> Next value of selection (wrap if needed)
<Up Arrow> Previous value of selection (wrap if needed)
<Enter> Enter selection if inside list or text entry box; if button is selected,

then choose it
<Esc> Exit without making changes if inside list or text entry box
<Alt-mnemonic> Selects the corresponding menu or option in the foremost window
<Alt-Space> Activates control menu
<Alt> Activates menu bar

You can use the following keyboard commands with menus.

<Left Arrow> Previous menu (wrap if needed)
<Right Arrow> Next menu (wrap if needed)
<Up Arrow> Move up one item (wrap if needed)
<Down Arrow> Open menu if not open;  move down one item
<Mnemonic> Open menu if not open using underlined character;  select item in

menu using underlined character
<Enter> Choose selected menu item
<Esc> Close menu if open;  deactivate menu bar
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Appendix C
Capture Display Mnemonics
                                                                                                                                                 

This appendix explains the mnemonics that appear in the capture display of the GPIB
analyzer.

DAB GPIB data byte captured using the data transfer or handshake line transition.

GPIB command bytes captured using the command transfer or handshake line transition:

ACG Addressed command group.
CFE Configuration enable.
DCL Device clear.
GET Group execute trigger.
GTL Go to local.
LA0-LA31 Listen addresses 0-30.
LLO Local lock out.
PPC Parallel poll configure.
PPU Parallel poll unconfigure.
SC0-SC30 Secondary command 0-30*.
SDC Selected device clear.
SPD Serial poll disable.
SPE Serial poll enable.
TCT Take control.
TA0-TA30 Talk addresses 0-30.
UCG Universal command group.
UNL Unlisten.
UNT Untalk.

GPIB parallel poll responses captured using the parallel poll response capture stimulus:

PP-B Parallel poll is beginning.
PP-E Parallel poll is ending.
PP-R Parallel poll response (occurs between PP-B and PP-E).

* If SC appears after a talk or listen address, it is a secondary address.  If it appears
after a parallel poll configure, it is either a parallel poll enable (PPE) or a parallel poll
disable (PPD) command.  If it appears after configuration enable (CFE), it is the
cable length for HS488.
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Appendix D
Customer Communication
                                                                                                                                                   

For your convenience, this appendix contains forms to help you gather the
information necessary to help us solve technical problems you might have as well
as a form you can use to comment on the product documentation.  Filling out a
copy of the Technical Support Form before contacting National Instruments helps
us help you better and faster.

National Instruments provides comprehensive technical assistance around the
world.  In the U.S. and Canada, applications engineers are available Monday
through Friday from 8:00 a.m. to 6:00 p.m. (central time).  In other countries,
contact the nearest branch office.  You may fax questions to us at any time.

Corporate Headquarters
(512) 795-8248
Technical support fax: (800) 328-2203

(512) 794-5678

Branch Offices Phone Number Fax Number
Australia 03 9 879 9422 03 9 879 9179
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Canada (Ontario) 519 622 9310 519 622 9311
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 71 11
Finland 90 527 2321 90 502 2930
France 1 48 14 24 24 1 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Italy 02 48301892 02 48301915
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 95 800 010 0793 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden  08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
U.K. 01635 523545 01635 523154



Technical Support Form
                                                                                                                                                 

Photocopy this form and update it each time you make changes to your software or
hardware, and use the completed copy of this form as a reference for your current
configuration.  Completing this form accurately before contacting National
Instruments for technical support helps our applications engineers answer your
questions more efficiently.

If you are using any National Instruments hardware or software products related to this
problem, include the configuration forms from their user manuals.  Include additional
pages if necessary.

Name                                                                                                                                  

Company                                                                                                                                  

Address                                                                                                                                  

                                                                                                                                 

Fax (         )                               Phone (         )                                                                 

Computer brand                                                                                                                       

Model                                    Processor                                                                   

Operating system                                                                                                              

Speed                                        MHz RAM                           MB

Display adapter                                                                                                                

Mouse                       yes                     no

Other adapters installed                                                                                                   

Hard disk capacity                       MB Brand                                                            

Instruments used                                                                                                            

National Instruments hardware product model                                                                        

Revision                                                                                                                          

Configuration                                                                                                                   

National Instruments software product                                                                                   

Version                                                                                                                            

Configuration                                                                                                                   

(continues)



The problem is                                                                                                                       

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

List any error messages                                                                                                          

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

The following steps will reproduce the problem                                                                    

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   

                                                                                                                                                   



GPIB Hardware and Software Configuration
Form
                                                                                                                                                 

Record the settings and revisions of your hardware and software on the line to the right of
each item.  Complete a new copy of this form each time you revise your software or
hardware configuration, and use this form as a reference for your current configuration.
Completing this form accurately before contacting National Instruments for technical
support helps our applications engineers answer your questions more efficiently.

National Instruments Products

• GPIB Hardware Product and Revision                                                                            

• GPIB Analyzer Software Revision                                                                                  

• NI-488.2 Software Revision Number on Distribution Disk(s)                                        

• Programming Language Interface Revision                                                                  

• Information from ni-pnp /v                                                                                       

• Board Settings

Base I/O
Address

Interrupt
Level

DMA
Channel

gpib0                                                             

gpib1                                                             

gpib2                                                             

gpib3                                                             

Other Products

• Computer Make and Model                                                                                            

• Microprocessor                                                                                                              

• Clock Frequency                                                                                                            

• Type of Monitor Card Installed                                                                                    

• Windows Version                                                                                                          



• Application Programming Language (BASICA, Microsoft C, and so on)                    

                                                                                                                                         

• Intel Plug and Play Software Installed (yes or no)                                                        

• Other Boards in System                                                                                                 

• Base I/O Address of Other Boards                                                                                 

• Interrupt Level of Other Boards                                                                                    

• DMA Channels of Other Boards                                                                                    



Documentation Comment Form
                                                                                                                                                 

National Instruments encourages you to comment on the documentation supplied with
our products.  This information helps us provide quality products to meet your needs.

Title: GPIB Analyzer User Manual

Edition Date: March 1996

Part Number: 370888A-01

Please comment on the completeness, clarity, and organization of the manual.

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

(continues)



If you find errors in the manual, please record the page numbers and describe the errors.

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

                                                                                                                                                 

Thank you for your help.

Name                                                                                                                                     

Title                                                                                                                                   

Company                                                                                                                                

Address                                                                                                                                  

                                                                                                                                  

Phone (            )                                    

Mail to: Technical Publications
National Instruments Corporation
6504 Bridge Point Parkway
Austin, TX  78730-5039

Fax to: Technical Publications
National Instruments Corporation
(512) 794-5678
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Glossary
                                                                                                                                                   

Prefix Meaning Value

n-
µ-
m-
k-
M-

nano-
micro-
milli-
kilo-
mega-

10-9

10-6

10-3

103

106

ASCII American Standard Code for Information Interchange

DIO digital input/output

EOI end or identify

EOS End-of-String

GPIB General Purpose Interface Bus

hex hexadecimal

HS488 high speed IEEE 488 transfers

IEEE Institute of Electrical and Electronic Engineers

LED light-emitting diode

m meters

s seconds
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Index
                                                                                                                                                   

A

Accept Byte button, 2-4 to 2-5, 3-1 to 3-2
acceptor handshake.  See handshake.
Action window, 2-1, 2-2, 2-3, 3-1
active Capture Display window, 2-8, 2-11,

3-2, A-2
analyzing captured GPIB events, 1-2, 3-5

to 3-8
application program, GPIB, 1-1, 5-1 to

5-10
ASCII box, 2-4, 2-5, 2-7, 2-12, 3-1, 3-3
asserting GPIB lines, 2-4 to 2-5, 3-1 to 3-2

B

buffer overflow.  See overflow errors.
buffer size, 2-5, 2-10, 3-3, 3-4 to 3-5
Bus Monitor window, 2-4 to 2-5, A-2

C

Capture Display window, 2-1, 2-2, 2-8 to
2-11

active, 2-8, 2-11, 3-2, A-2
inactive, 2-8, 2-11, 3-7, 3-8, A-2

capture file
exporting 2-9, 3-8
opening, 2-2, 3-2
printing, 2-9, 3-7
saving, 2-9, 3-7

capture settings, 2-5 to 2-8, 3-2 to 3-3
capture stimulus, 2-6, 2-10, 3-3
capturing GPIB events

how to, 3-2 to 3-5
non-intrusive capture, 3-4
overview, 1-2
tutorial, 4-1 to 4-11

colors in the capture display, 3-5 to 3-6
command transfers, 2-6
common questions, A-1 to A-2
control lines, 2-5 to 2-6, 3-1
customer communication, x, D-1

D

data transfers, 2-5 to 2-6
display mode, 2-11, 3-5, 3-7, A-2
documentation

conventions used in manual, x
organization of manual, ix
related documentation, x

E

errors
GPIB timeout errors, 5-8
overflow errors, 2-11, 3-4 to 3-5

examples using analyzer, 5-1 to 5-10
exiting GPIB analyzer program, 2-2, 3-1
exporting capture displays, 2-9, 3-8, 4-11

F

Find button, 2-10, 2-12, 2-13, 3-7, 4-7 to
4-9

Find window, 2-12 to 2-13, 3-7
find specifications, 2-13
finding captured GPIB events.  See

searching for captured GPIB
events.

G

GPIB analyzer
capture rate, 3-2
examples, 5-1 to 5-10
exiting, 2-2, 3-1
installation, 1-3
overview, 1-1 to 1-2
starting, 1-3
tutorial, 4-1 to 4-11

GPIB applications, 1-1, 5-1 to 5-10
GPIB lines, 1-2, 2-4, 2-6, 2-7, 3-1 to 3-2
GPIB transfer rate, 2-6, 3-3
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H

handshake
checkboxes, 2-6
lines, 2-6, 3-1
participation, 1-2, 2-6, 3-3 to 3-4, A-1
rate, 2-6, 2-10, 3-3, A-1

Hex box, 2-4, 2-5, 2-7, 2-12, 3-1, 3-3

I

IEEE 488 problems.  See troubleshooting
IEEE 488 problems.

inactive capture display window, 2-8,
2-11, 3-7, 3-8, A-2

input bus state, 2-12 to 2-13
installation, GPIB analyzer, 1-3

K

keyboard commands, B-1

L

LEDs, 2-4, 3-1, A-2

M

Main window, 2-2 to 2-3
markers, 2-10, 3-7, 4-10
mnemonics, capture display, 3-7, C-1
monitoring GPIB activity, 1-2, 2-4,

3-1 to 3-2

N

NI-488.2 software, 1-3, 4-1
non-intrusive capture, 3-4

O

online help, 1-1
overflow errors, 2-11, 3-4 to 3-5

overview, GPIB analyzer, 1-1 to 1-2
P

parallel poll responses, 2-5 to 2-6, C-1
printing captured GPIB events

how to, 2-9, 3-7
tutorial, 4-11

R

rates
GPIB analyzer capture, 3-2
GPIB transfer, 2-6, 3-3
handshake, 2-6, 2-10, 3-3, A-1

S

saving
captured GPIB events, 2-9, 3-7, 4-7
settings file, 2-3, 3-5, 4-2

searching for captured GPIB events
how to, 2-12 to 2-13, 3-7
tutorial, 4-7 to 4-10

serial polls, 5-3 to 5-6, C-1
service request problems

example, 5-3 to 5-6
settings file

changing, 2-3
loading, 2-3, 3-5
saving, 2-3, 3-5

Settings window, 2-3, 2-5 to 2-8, 3-2 to
3-4

starting capture process, 3-1, 3-2
starting GPIB analyzer program, 1-3
statistics, capture display, 2-10, 3-7
stopping capture process, 2-3, 3-1

T

technical support, D-1
timestamp

checkbox, 2-6, 3-3, 3-4
values, 3-6, A-2

trigger condition
boxes, 2-7
changing, 3-3 to 3-4
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searching for, 2-13
trigger point.  See trigger condition.
trigger settings, 2-7 to 2-8
triggering on GPIB event.  See also trigger

condition.
how to, 3-3 to 3-4, A-1
overview, 1-2
trigger controls, 2-7 to 2-8
tutorial, 4-4 to 4-7

troubleshooting IEEE 488 problems
examples, 5-1 to 5-10
overview, 1-1

V

viewing
capture data, 3-5 to 3-7, 4-1 to 4-7
GPIB line states, 2-4 to 2-5, 3-1

W

windows of the GPIB analyzer.  See also
specific window names.

Action window, 2-3
Bus Monitor window, 2-4 to 2-5, A-2
Capture Display window, 2-8 to 2-11
Find window, 2-12 to 2-13
Main window, 2-2 to 2-3
overview, 2-1
Settings window, 2-5 to 2-8
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